Notice

Aprisma Management Technologies, Inc. (Aprisma) reserves the right to make changes in specifications and other information contained in this document without prior notice. The reader should in all cases consult Aprisma to determine whether any such changes have been made. The hardware, firmware, or software described in this manual is subject to change without notice. IN NO EVENT SHALL APRISMA, ITS EMPLOYEES, OFFICERS, DIRECTORS, AGENTS, OR AFFILIATES BE LIABLE FOR ANY INCIDENTAL, INDIRECT, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING BUT NOT LIMITED TO LOST PROFITS) ARISING OUT OF OR RELATED TO THIS MANUAL OR THE INFORMATION CONTAINED IN IT, EVEN IF APRISMA HAS BEEN ADVISED OF, KNOWN, OR SHOULD HAVE KNOWN, THE POSSIBILITY OF SUCH DAMAGES.

Copyright © June 2000 by Aprisma Management Technologies, Inc. All rights reserved.
Printed in the United States of America.
Order Number: 9033518-01

Aprisma Management Technologies, Inc.
121 Technology Way
Durham NH 03824

SPECTRUM, the SPECTRUM IMT/VNM logo, DCM, IMT, and VNM are registered trademarks, and SpectroGRAPH, SpectroSERVER, Inductive Modeling Technology, Device Communications Manager, and Virtual Network Machine are trademarks of Aprisma or its affiliates.
C++ is a trademark of American Telephone and Telegraph, Inc.
UNIX is a trademark of UNIX System Laboratories, Inc.
OSF/Motif and Motif are trademarks of the Open Software Foundation, Inc.
X Window System is a trademark of X Consortium, Inc.
Ethernet is a trademark of Xerox Corporation.

Virus Disclaimer

Aprisma makes no representations or warranties to the effect that the Licensed Software is virus-free.
Aprisma has tested its software with current virus checking technologies. However, because no anti-virus system is 100% reliable, we strongly caution you to write protect and then verify that the Licensed Software, prior to installing it, is virus-free with an anti-virus system in which you have confidence.
Restricted Rights Notice

(Applicable to licenses to the United States Government only.)

1. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013.


2. (a) This computer software is submitted with restricted rights. It may not be used, reproduced, or disclosed by the Government except as provided in paragraph (b) of this Notice or as otherwise expressly stated in the contract.

   (b) This computer software may be:

   (1) Used or copied for use in or with the computer or computers for which it was acquired, including use at any Government installation to which such computer or computers may be transferred;

   (2) Used or copied for use in a backup computer if any computer for which it was acquired is inoperative;

   (3) Reproduced for archival or backup purposes;

   (4) Modified, adapted, or combined with other computer software, provided that the modified, combined, or adapted portions of the derivative software incorporating restricted computer software are made subject to the same restricted rights;

   (5) Disclosed to and reproduced for use by support service contractors in accordance with subparagraphs (b) (1) through (4) of this clause, provided the Government makes such disclosure or reproduction subject to these restricted rights; and

   (6) Used or copied for use in or transferred to a replacement computer.

(c) Notwithstanding the foregoing, if this computer software is published copyrighted computer software, it is licensed to the Government, without disclosure prohibitions, with the minimum rights set forth in paragraph (b) of this clause.

(d) Any other rights or limitations regarding the use, duplication, or disclosure of this computer software are to be expressly stated in, or incorporated in, the contract.

(e) This Notice shall be marked on any reproduction of this computer software, in whole or in part.
## Contents

### Introduction
- Prerequisites ................................................................................................................ 7
- ATM Circuit Manager Modeling Schemes .................................................................... 7
  - Modeling Scenario #1 ............................................................................................... 7
  - Modeling Scenario #2 ............................................................................................... 8
  - Modeling Scenario #3 ............................................................................................... 8
- Required MIBs ............................................................................................................. 8
- SpectroGRAPH Models ............................................................................................... 9
  - ATM_Cloud ........................................................................................................... 9
  - ATM_Network ....................................................................................................... 10
  - ATM Interface ...................................................................................................... 11
  - ATMVC1Link ......................................................................................................... 11
  - UnmanAtmLink ..................................................................................................... 12
- Modeling Paradigms .................................................................................................... 12
  - The Older Methodology ......................................................................................... 12
  - The New Modeling Paradigm .................................................................................. 14
- Terminology .................................................................................................................... 15

### Modeling the ATM Circuits
- ATM and Frame Relay ............................................................................................... 22

### Using ATM Circuit Manager
- Configuring and Monitoring Link Models .................................................................. 24
- Starting the ATM Logical Connection View ............................................................ 25
- Managed Links .......................................................................................................... 27
- Unmanaged Links .................................................................................................... 29
  - Using the ATM Logical Connection View to Create Unmanaged Link Models .... 29
- ATM and Frame Relay Virtual Links .......................................................................... 30
- Remote Ping ............................................................................................................... 31
  - To Change the Remote Ping Configuration .............................................................. 33
- ACMAsciiModelingApp .............................................................................................. 34
- ATM Link Threshold View ........................................................................................ 36
- Setting Up Thresholds ............................................................................................... 38
Introduction

This document describes the ATM Circuit Manager application including the modeling scheme by which SPECTRUM models ATM circuits, the functionality provided by this modeling scheme, and how application is used to manage ATM networks.

Asynchronous Transfer Mode (ATM) is based on the transmission of fixed-length (53-byte) cells of data. Contrast this with an Ethernet LAN, which transmits variable-length packets ranging in size from 64 to over 1500 bytes of data. ATM’s use of small, fixed-length data cells allows for improved traffic management and traffic shaping.

ATM is a connection-oriented network communication architecture, which generally means that it transmits data through pre-established virtual channels (circuits), similar to telephone calls. Virtual channels may be established automatically by Switched Virtual Circuit (SVC) signaling or they may be set up manually by the network administrator to form Permanent Virtual Circuits (PVCs).

Each ATM cell contains a five-byte header and 48 bytes of payload. The header includes a Virtual Path Identifier (VPI) and a Virtual Channel Identifier (VCI). These identifiers are used by ATM switches to determine the correct channels to transmit particular cells. Transmission is controlled by statistical multiplexing, which awards bandwidth (channels) to devices ready to send data on a first come, first served basis.

The combination of small, fixed-length data cells and the efficient use of bandwidth (among other things) allow ATM switches to communicate time-critical video and audio data along with other computer data across the ATM network. In an end-to-end transmission across a mixed LAN/ATM/LAN network, packets transmitted by a LAN workstation to an ATM switch are segmented into cells for high speed transmission through ATM channels. At the receiving end, cells are reassembled into packets for use by another LAN workstation.
Prerequisites

You must be familiar with ATM network technology before using the ATM Circuit Manager application and this document. This document is not meant to be an explanation of ATM and networking. In order to set thresholds and determine connections, you must be completely familiar with the service provider’s contract and with the ATM network’s topology.

ATM Circuit Manager Modeling Schemes

There are three different modeling schemes that can be used to model ATM networks. These schemes are dependent on the type of ATM network that a SPECTRUM customer has. There are three ATM network types:

1. Customers who own and administer the switches that comprise the ATM fabric.
2. Customers who use an ATM service provider to provide wide-area connectivity and have no management access to the ATM switches.
3. Customers who own their own ATM switches and connect to a service provider’s network.

Modeling Scenario #1

Customers who own their own ATM switches will use an ATM_Network model to represent their switched fabric. Switch models will appear within the ATM_Network model and will have a Collects association with that model. Client models will have an Is_Adjacent_to association with the ATM_Network model.
Modeling Scenario #2

If an ATM service provider is used to provide wide-area connectivity to remote sites, there is no management access to the service provider’s ATM switches. The ATM clients must provide all the data to monitor the ATM circuits. To facilitate the modeling of this type of network, a new SPECTRUM model type, ATM_Cloud, has been introduced. All ATM interfaces that connect to the service provider’s network will have a Connects_to association with the ATM_Cloud model. This modeling association can be established manually by copying and pasting the ATM_Cloud model onto those interfaces.

Modeling Scenario #3

If the SPECTRUM user owns their own local ATM switches but still connects to a service provider’s network for wide-area access, interface models of ATM switches will be connected to the ATM_Cloud model. SPECTRUM intelligence will automatically create VPL (Virtual Path Link) and VCL (Virtual Channel Link) models to represent the VPLs and VCLs that run over an interface connected to the ATM_Cloud model.

Required MIBs

When managing physical connections, SPECTRUM queries the routers in the network for interface status and statistics. When managing virtual connections, SPECTRUM queries the network’s switches and their clients for VCL and VPL status and statistics.

Management of logical connections requires that the devices making the connections support the necessary SNMP MIBs. To fully utilize the performance monitoring and threshold alarming functionality of the ATM Circuit Manager, the following MIBs must be supported by the managed devices:

- RFC1695 which provides up/down status information for each ATM link. The RFC1695 MIB is necessary for fault notification.
• ATM2 MIB which provides in cells/out cells counter statistics for each ATM link. Without the cell counters inherent in this MIB, no thresholds can be set for a circuit and no performance information will be available.

![Note]

The ATM2 MIB is currently an internet draft that is not yet an RFC. However, the ATM2 MIB is necessary to monitor the performance of the VCLs/VPLs.

• In addition, SPECTRUM supports the Cisco CA-CONN-MIB (found on Lightstream switches), and the Fore Switch MIB. Either of these MIBs provide the statistics necessary to monitor the performance of the ATM links.

**SpectroGRAPH Models**

This section provides descriptions of the new model types and corresponding models that have been developed to manage ATM circuits with SPECTRUM. Using these new models to manage your ATM network is described in detail in the *Using ATM Circuit Manager* section of this document.

**ATM_Cloud**

The ATM_Cloud model is used in modeling situations where an ATM service provider is used to provide wide-area connectivity to remote sites and there is no management access to ATM switches. The ATM clients must provide all the data to monitor the ATM circuits. The ATM_Cloud model also provides access to the ATM Logical Connection view.
ATM_Network
The ATM_Network model represents a completely managed ATM switched fabric. It also provides access to the ATM Logical Connection view.
**Introduction**

**SpectroGRAPH Models**

**ATM Interface**

This model provides access to a Device Topology view containing the sub-interface models. *Connects_to* associations with the ATM Interface model represent the physical, interface-to-device, or interface-to-ATM_Cloud connectivity.

**ATMVclLink**

This "link" model represents an endpoint of a virtual connection. Each VCL or VPL acts, in many ways, like an interface model. SPECTRUM retrieves circuit status and statistics for the connection by monitoring these endpoint models. SPECTRUM logs statistics from these models which can then be used to generate reports. SPECTRUM generates alarms based on the status of these models. For example, if the load of an ATM "link" model exceeds a predefined threshold, SPECTRUM alerts the user with an alarm. Management of PVPs (Permanent Virtual Paths) and PVCs (Permanent Virtual Channels) in SPECTRUM is achieved by polling and logging attributes of the VPL and VCL models.
UnmanAtmLink

The UnmanAtmLink model represents an unmanageable ATM link. Some ATM paths or circuits may be manageable from only one end-point. The device on one side may not have an SNMP Agent or may be inaccessible for some other reason. For these links, the UnmanAtmLink model can be created and associated to the end-point that does have management. This allows SPECTRUM to manage this type of link.

Modeling Paradigms

The Older Methodology

Before ATM Circuit Manager, it was impossible to accurately represent the connectivity of switches and/or routers in a service provider’s network. In a fully or partially meshed network, each physical ATM Interface may have logical connections with many other ATM devices. However, previous SPECTRUM modeling functionality only allowed a single connection per interface model.

For this reason, many SPECTRUM users created a WA_Link model to represent the ATM service provider’s network and all ATM interfaces were connected to a WA_Segment model collected by the WA_Link model (Figure 1). This provided an adequate representation of the physical connectivity unless there were managed switches between some of the clients. The true data relay paths between the clients were not known and proper fault isolation could not be guaranteed.
Figure 1: The Older Methodology
**The New Modeling Paradigm**

The ATM Circuit Manager creates models to represent each virtual path link and virtual channel link. Each virtual link model may be associated with another link model to indicate the “logical connectivity” of the interface through the ATM Logical Connection view. The physical connectivity is still indicated by a `Connects_to` association with the ATM interface model on the left side of the view and the connected device model on the right.

![The New Modeling Paradigm](image-url)
Terminology

Path
A large communications pipe that pre-allocates bandwidth and allows for greater flexibility in establishing PVCs. A defined amount of bandwidth is leased from a service provider and you can establish as many PVCs as necessary within the limits of that bandwidth.

Channel
A data transmission link between two or more points.

Permanent Virtual Path (PVP)
A logical communications path that has a defined amount of leased bandwidth. This path is maintained at all times even if it is not always in use.

Permanent Virtual Circuit (PVC)
A logical connection that is manually created by a network administrator. This connection is maintained at all times even if it is not always in use. PVCs can exist without being part of a PVP.

Virtual Path Identifier (VPI)
The field of a cell header that contains the address of the virtual path.

Virtual Channel Identifier (VCI)
The field of a cell header that contains the address of the virtual channel.
Modeling the ATM Circuits

This section describes the procedures for modeling an ATM network in SPECTRUM.

As previously stated, there are three possible modeling schemes depending on the user’s ATM environment:

1. The entire switched fabric is owned and managed by the customer (Figure 3)
2. All channels are leased through a service provider’s network (Figure 5)
3. There is a local area ATM network owned and managed by the customer and additional wide-area channels that are leased through a service provider’s network (Figure 6)

There are three procedures for modeling an ATM network with SPECTRUM:

1. Creating and resolving all models manually.
2. Using the discovery process provided by the ACMAsciiModelingApp.
3. Incrementally adding new circuits if you already have a fully-meshed, switched network.

If the customer is managing the switched fabric, there will be one or more ATM_Network models in the SPECTRUM topology. The ATM switches will be collected by the ATM_Network models and the ATM clients will be adjacent to the ATM_Network model (Figure 3).

Auto Discovery maps the physical connectivity between ATM switches and places these switch models inside ATM_Network container models. Auto Discovery also places SW_Link models between connected ATM Interface models. If you model your ATM network manually, you can connect the ATM Interface models directly to the switch or client models but they must be collected by an ATM_Network model to get the benefit of the Logical Connection view.
The ATM circuits go from one client, through the ATM_Network, to another client. The links within the switched fabric itself will not be managed, unless the user specifically requests it.

**Figure 3: Modeling a Completely Owned Network**

*Note: If the customer is leasing channels through a service provider’s network, there will be an ATM_Cloud model in the SPECTRUM topology.*
Every ATM interface that connects to the service provider’s network must be connected manually to the ATM_Cloud model. This can be done by copying the ATM_Cloud and pasting it onto the ATM interface in the Device Topology view of each device.

1. In the Topology view, select **Edit** from the File menu.
2. Highlight the ATM_Cloud model.
3. Select **Copy** from the Edit menu.
4. Select **Close Edit** from the File menu.
5. Navigate into the ATM device’s Device Topology view.
6. Select **Edit** from the File menu.
7. Select **Paste** from the Edit menu.
8. Paste the ATM_Cloud model onto the ATM Interface model.
Figure 4: Pasting the ATM_Cloud Model into a Device Topology View
It is possible for a customer to have a local ATM network and use ATM wide-area services from a service provider. In this case, interfaces from some of the switches may be connected to the ATM_Cloud and other switches go from client to client through the ATM_Network. This will make the ATM_Network adjacent to the ATM_Cloud. This is the only scenario in which the virtual link of a switch will be managed as an endpoint of a circuit. (In other cases, the virtual links of the clients, not switches are managed).
Figure 6: Modeling a Completely Owned ATM LAN and Leased ATM Wide-Area Links
ATM and Frame Relay

It is possible to have a hybrid ATM network with both ATM and Frame Relay interfaces. A customer may be using a completely leased network through a service provider and, depending on the type of applications they are using, there could be a mixture of ATM and Frame Relay interfaces on either side of the leased network.

For example, a customer could be running a graphical medical software application which would require using ATM and ATM interfaces in one part of their network. However, a remote office might be using Frame Relay for communications and would not require ATM. Signals transmitted from an ATM interface going through the service provider’s network would be converted to Frame Relay by a translational bridge before being received by the Frame Relay interface or Frame Relay signals could be converted to ATM (Figure 7).

Note: To use Frame Relay with the ATM Circuit Manager Application, you must have purchased and installed the SPECTRUM Frame Relay Manager Application. Contact SPECTRUM Support for more information.
The modeling procedure for this scenario would be identical to the procedure for modeling a completely leased network, as described previously.
Using ATM Circuit Manager

This section describes managing ATM Circuits with SPECTRUM. It provides information on setting up thresholds, monitoring network performance, and diagnosing some common network problems.

SPECTRUM management of PVPs and PVCs on ATM switches and ATM clients consists of:

• Performance monitoring and reporting
• Load threshold alarming
• Circuit fault notification
• Service Provider/Customer tracking

Configuring and Monitoring Link Models

This section describes managing link models through the VCL Quality of Service and VCL Threshold views. VCL Link models are displayed in the ATM Logical Connection view or the sub-interface view of an ATM Interface model. VCL Link models allow you to:

• View the quality of service information through the VCL Quality of Service Information view
• Monitor real-time performance of the channel through the Performance view.
• Set thresholds through the VCL Threshold view.

Note:
To use the Performance and Threshold views, your device must support the ATM2 MIB or one of the supported proprietary MIB extensions. Without the cell counters inherent in this MIB, no thresholds can be set for a circuit and no performance information will be available.
The Logical Connection view displays all of the managed virtual circuits that go through the switched fabric represented by the ATM_Cloud or ATM_Network model from which it was launched.

**Starting the ATM Logical Connection View**

The ATM Logical Connection view is accessed from the ATM_Cloud or ATM_Network model. Access the ATM Logical Connection view, as follows:

1. Highlight the ATM_Cloud or ATM_Network icon
2. Access the Icon Subviews menu by selecting **Icon Subviews** from the View menu or by clicking on the ATM_Cloud or ATM_Network icon with the right mouse button
3. Select **ATM Logical Connection View** from the Icon Subviews menu
Figure 8: The ATM Logical Connection View
Managed Links

A managed virtual circuit is a circuit whose endpoint models in SPECTRUM are associated by the Links_with relation. By default, none of the circuits through the switched fabric are managed.

This is mostly because there is no way of autodiscovering the circuits that go through a service provider’s network because it is not possible to have SNMP contact with a service provider's switches. The Logical Connection view provides management of these circuits by allowing a user to establish a Links_with association between any two virtual link models of interfaces adjacent to the ATM_Cloud or ATM_Network model. This is the normal method of indicating a virtual circuit to SPECTRUM. SPECTRUM will use this information during the fault isolation process.

After the clients, switches, and containers have been modeled and connected in the SPECTRUM topology, you can launch the Logical Connection view from the ATM_Network or ATM_Cloud icons. The Logical Connection view initially indicates that there are no connected virtual links. To provide management for the clients' virtual circuits, do the following:

1. Click on the "Add" toolbar button to access the Add Link view (Figure 9).

All adjacent interfaces will be displayed. To establish the Links_with association between two virtual links:

2. Select the interface on the left side and the interface on the right side.
3. Select the link on the left side and the link on the right side.
4. Click the Add button.

The Links_with association will be added to the virtual link models and the connection will be displayed in the Logical Connection view.
Figure 9: The Add Link View
Unmanaged Links

It is possible for a SPECTRUM user to be responsible for a circuit, but not have SNMP contact with the device on one side. If this is the case, the Unmanaged Link option provides a mechanism to manage the circuit from a single endpoint.

There are two methods by which a user would create UnmanagedAtmLink models:

1. The first and primary way is through the use of the ATM Logical Connection view. In this view, the user will be able to select a currently-modeled, manageable ATM link and create a connection between it and an unmanaged ATM link.

2. The second method is using the ACMAsciiModelingApp application. This application uses an ascii file containing ATM link data to model a customer's network.

Using the ATM Logical Connection View to Create Unmanaged Link Models

At the bottom of the right hand VPL/VCL list, there is a selection for "Unmanaged Link". To create Unmanaged Link models:

1. Select an ATM Interface and link model on the left side of the Add Link view.
   This will be the single-point of management for this connection.

2. Highlight "Unmanaged Link" on the right side of the ATM Logical Connection view

3. Click on the Add button

You will be asked to provide some additional information about this endpoint. The information entered will be displayed in this view, but used only for display purposes. The only required field is model name.
When the "Unmanaged Link" option is used, the Logical Connection view creates a new model of type **UnmanAtmLink** and associates this model with the ATM_Network/ATM_Cloud model via the *Contains* relation. A *Links_with* association is then created between the "left side" link model and the new UnmanAtmLink model.

### ATM and Frame Relay Virtual Links

In a situation where there is a mixture of ATM and Frame Relay interfaces on either side of the leased service provider’s network, the Logical Connection view can provide management of either type of circuit by allowing a user to establish a *Links_with* association between the ATM and Frame Relay virtual link models.

To provide management for the ATM and Frame Relay virtual circuits, do the following:

1. Click on the "Add" toolbar button to access the Add Link view.
   
   All adjacent interfaces will be displayed. To establish the *Links_with* association between the ATM and the Frame Relay virtual links:

2. Select the interface on the left side and the interface on the right side.

3. Select the link on the left side and the link on the right side.

4. Click the **Add** button.

The *Links_with* association will be added to the ATM and Frame Relay virtual link models and the connection will be displayed in the Logical Connection view. The Frame Relay side of the link will display a DLCI Port model. See the **Frame Relay Manager User’s Guide** for information on the DLCI Port model.
Remote Ping

If you have Cisco routers on your ATM network, the ATM Circuit Manager initiates remote pings to determine the status of ATM PVCs through the CiscoPingApp application. Remote pings are initiated from one router to another. An inference handler examines the ATM connections for a particular router, and instructs that router to ping the IP addresses of the routers on the other side of the ATM PVC. If the ping fails, an event will be sent to the ATM link model that represents this router's side of the ATM PVC. This should result in a red alarm being generated on this model.

The ATM Circuit Manager will only initiate 5 remote pings per router at a time until all remote pings have been tried. This will prevent the possibility of the router becoming overloaded.

Table 1 shows the remote ping application attributes that can be modified.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Default Setting</th>
<th>Attribute ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EnableRemotePing</td>
<td>True</td>
<td>c4063f</td>
<td>Enables/Disables remote pinging. If set to “False” pinging is disabled.</td>
</tr>
<tr>
<td>PingInterval</td>
<td>300</td>
<td>c40640</td>
<td>The interval, in seconds, between remote ping requests.</td>
</tr>
<tr>
<td>NumberOfPingPackets</td>
<td>3</td>
<td>c40641</td>
<td>The number of ping packets the router will send to the remote IP address.</td>
</tr>
</tbody>
</table>
EnableRemotePing
When set to “False” disables remote pinging from the router. If the ATM network has redundant paths set up or if the OSPF (Open Shortest Path First) routing protocol is being used, remote pinging may return information that is not completely useful in determining the health of the network and, therefore, will use up unnecessary bandwidth.

PingInterval
NumberOfPingPackets
PingFailuresAllowed

The three attributes above would be used in conjunction to increase the frequency of remote pinging and the speed of any network fault detection.

For example: if “PingInterval” was lowered to 60, “NumberOfPingPackets” remained set at “3”, and “PingFailuresAllowed” was decreased to “0”, ping requests would be initiated more frequently and no failure of any of these requests would be allowed. This would result in the ATM network being more closely monitored for remote link problems and, if problems were discovered, alarms would be generated more quickly.

Table 1: Remote Ping Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Default Setting</th>
<th>Attribute ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PingPacketSize</td>
<td>128</td>
<td>c40642</td>
<td>The size of a ping packet, in bytes, that the router will send to the remote IP address.</td>
</tr>
<tr>
<td>PingFailuresAllowed</td>
<td>2</td>
<td>c40642</td>
<td>The number of ping request failures allowed before an alarm is generated.</td>
</tr>
</tbody>
</table>
To Change the Remote Ping Configuration

To change the configuration of the remote ping application, you can use the Command Line Interface (CLI) tool. You must determine the model handle of the CiscoPingApp of interest and update the model with the new configuration. Do the following:

1. From the command line in the directory `<SPECTRUM Installation Directory>/vnmsh/` enter the following to determine the model handle and press **Return**:

   ```
   show models | grep CiscoPingApp
   ```

   The system will return information similar to the following:

<table>
<thead>
<tr>
<th>Model Name</th>
<th>Model Type Handle</th>
<th>Model Type Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>bird</td>
<td>0x2dc000</td>
<td>CiscoPingApp</td>
</tr>
<tr>
<td>montana</td>
<td>0x2dc000</td>
<td>CiscoPingApp</td>
</tr>
<tr>
<td>spec203</td>
<td>0x2dc000</td>
<td>CiscoPingApp</td>
</tr>
<tr>
<td>dowland</td>
<td>0x2dc000</td>
<td>CiscoPingApp</td>
</tr>
</tbody>
</table>

2. Using the following format, change the configuration value(s) on the CiscoPingApp model of interest and press **Return**:

   ```
   update model <model name> attrid=<attribute ID>,val=<value>
   ```

   **For example:**

   ```
   update model <dowland> attrid=c40642,val=0
   ```
ACMAsciiModelingApp

To facilitate the modeling a hundreds of virtual circuits, an ASCII file import application is included with the ATM Circuit Manager. This application takes a text file as a parameter and automatically establishes the Links_with association between the link models indicated in the file. The application assumes that the physical connectivity modeling has already been done, including connecting all appropriate interfaces to an ATM_Cloud (if a service provider's network is used). The format of the text file must be as follows:

`link_A.ip,link_A.oid,link_B.ip,&link_B.oid,circuit name,circuit id`

*Circuit name* and *circuit id* are optional parameters. The *oid* must be the two-term index of a VPL or the three-term index of a VCL. If no model representing link_B is found, the application will create an UnmanAtmLink and associate it with link_A. This circuit will then be managed by a single endpoint - link_A.

If the *circuit name* and *circuit id* parameters are specified, this information will be written to the existing models (or to the newly created UnmanAtmLink model).

To use this application, open a shell window, and change directories to `<SPECTRUM Installation Directory>/SG-Support/CsScript`. Run the application with the following syntax:

```
./ACMAsciiModelingApp <SpectroSERVER machine name> <input file> <output file>
```
If not specified, the application will create an output file name based on the date and time of execution. The output file contains information about which circuits were created successfully, and which failed. Sample output follows:

Found ATM link 4.0.16 at IP 172.19.59.56
Found ATM link 6.0.16 at IP 172.19.56.77
Successfully created ATM circuit!
Found ATM link 0.0.15 at IP 192.168.112.227
Found ATM link 0.0.15 at IP 192.168.112.228
Successfully created ATM circuit!
Found ATM link 0.0.14 at IP 192.168.112.227
Unable to find ATM link 5.0.47 at IP 172.12.47.134, but found existing circuit
Did not replace existing ATM circuit!
ATM Link Threshold View

ATM Link models have a Threshold view that allows the user to establish levels of activity that will generate alarms.

Figure 10: The Threshold View
The following thresholds can be set in this view:

**Received Load**
The average number of bits received by the ATM Link model since the last poll.

**Transmit Load**
The average number of bits transmitted by the ATM Link model since the last poll.

**Receive CPS**
The average number of cells per second received by the ATM Link model since the last poll.

**Transmit CPS**
The average number of cells per second transmitted by the ATM Link model since the last poll.

By default, the high threshold values for load are set to “90%” and reset at “80%” and the low threshold values are set and reset at “0” (disabled). The threshold values are recalculated at every poll cycle and represent the average number per poll.

The “Set” field for each attribute is the high threshold that, if exceeded, will generate an alarm for that attribute. The “Reset” field for each attribute is the low threshold that, if gone below, automatically clears the alarm for that attribute.

---

**Caution:**
Do not set the “Reset” field to “0.” If the the “Reset” field is set to “0” and the “Set” field is crossed, the subsequent alarm will never be cleared automatically. If this alarm is cleared manually by the user, the SPECTRUM threshold intelligence is not reset and the alarm for that model will not be generated again. To reset the threshold intelligence, the SpectroSERVER must be restarted.
To access the Threshold view, highlight the ATM Link model in the ATM Logical Connection view and select **Threshold** from the Icon Subviews menu.

**Setting Up Thresholds**

To set thresholds for an ATM Link model, do the following:

1. Access the ATM Logical Connection view.
2. Select **Threshold** from the left-side Model (A) Icon Subviews menu.
3. In the “Set” field for the desired attribute, enter the high threshold.
4. In the “Reset” field for the desired attribute, enter the low threshold.
5. Select **Save All Changes** from the File menu.

Figure 11 describes the functionality provided by the high and low threshold feature for ATM Link models.
**Figure 11: Thresholding**

Initial alarm is generated when high threshold value is exceeded.

Without a low threshold, a new alarm would be generated every time the high threshold value is exceeded. With a low threshold, only the initial alarm is generated.

Initial alarm is cleared when low threshold is crossed.

Timeline
VCL QoS Information View

The VCL QoS (Quality of Service) Information view provides receive and transmit parameters for this connection, the QoS class being used for the connection, and the bandwidth parameters used to calculate load.

QoS Classes

**Constant Bit Rate (CBR)** is a connection which supports applications that transmit at a fixed bandwidth. The amount of bandwidth is described by the Peak Cell Rate parameter. Constant Bit Rate works well for circuit emulation.

**Variable Bit Rate (VBR)** supports connections that require a variable bandwidth. The Peak Cell Rate, Sustained Cell Rate, and Maximum Burst Size parameters describe this type of QoS connection. Variable Bit Rate works well for voice and video compression transmissions.

**Unspecified Bit Rate (UBR)** is a connection which supports an open-ended bit rate and provides a “best effort” quality of service. Unspecified Bit Rate works well in the transmission of LAN data. It will use whatever bandwidth is available. If network congestion occurs, the data is placed in a buffer. If the buffer gets too full, the data is discarded.

**Available Bit Rate (ABR)** is an Unspecified Bit Rate connection with the addition of flow control protocols which attempt to prevent network congestion from occurring. It is still a “best effort” quality of service and is used for the transmission of LAN data.

Receive QoS Parameters

**QoS Class**
The QoS class used for this connection.

**QoS Peak Cell Rate**
The maximum number of cells per second the connection can receive from the network.
**QoS Sust Cell Rate**
The average number of cells per second the connection can receive from the network.

**QoS Max Burst Size**
The maximum length of time that the connection can receive cells from the network at the peak cell rate.

**QoS Tagging**
If “on”, tagging has been enabled. Tagging is the process of marking the CLP (Cell Loss Priority) bit of cells in an ATM network because they do not conform to the subscribed QoS contract. This identifies these cells as having a lower priority and would be the first cells to be dropped by the network in traffic congestion situations.

**QoS CLPO Peak Cell Rate**
The maximum number of cells per second with the CLP bit set that the connection can receive from the network.

**QoS CLPO Sust Cell Rate**
The average number of cells per second with the CLP bit set that the connection can receive from the network.

**QoS CLPO Max Burst Size**
The maximum length of time that the connection can receive cells with the CLP bit set from the network at the CLP peak cell rate.

**QoS Cell Delay VT**
The maximum time delay variation tolerance between the arrival one cell from the network and the arrival of the cell immediately following it. This is typically very low for CBR and VBR connections and very high for ABR and UBR connections.
Transmit QoS Parameters

**QoS Class**
The QoS class used for this connection.

**QoS Peak Cell Rate**
The maximum number of cells per second the connection can receive from the network.

**QoS Sust Cell Rate**
The average number of cells per second the connection can transmit on to the network.

**QoS Max Burst Size**
The maximum length of time that the connection can transmit cells on to the network at the peak cell rate.

**QoS Tagging**
If “on”, tagging has been enabled. Tagging is the process of marking the CLP (Cell Loss Priority) bit of cells in an ATM network because they do not conform to the subscribed QoS contract. This identifies these cells as having a lower priority and would be the first cells to be dropped by the network in traffic congestion situations.

**QoS CLPO Peak Cell Rate**
The maximum number of cells per second with the CLP bit set that the connection can transmit on to the network.

**QoS CLPO Sust Cell Rate**
The average number of cells per second with the CLP bit set that the connection can transmit on to the network.

**QoS CLPO Max Burst Size**
The maximum length of time that the connection can transmit cells with the CLP bit set on to the network at the CLP peak cell rate.
QoS Cell Delay VT
The maximum time delay variation tolerance between the transmission one cell on to the network and the transmission of the cell immediately following it. This is typically very low for CBR and VBR connections and very high for ABR and UBR connections.

Bandwidth Parameters

Receive Bandwidth
The number of cells per second received by this connection. This number is analogous to the received QoS parameters Sustained Cell Rate.

Transmit Bandwidth
The number of cells per second transmitted by this connection. This number is analogous to the transmit QoS parameters Sustained Cell Rate.
Figure 12: The VCL QoS Information View

VCL QoS Information View

ATM Link Name: 192.168.112.227  Contact Status: Established
Link Last Change: 0+00:00:00  Condition: Normal

Receive Qos Parameters

<table>
<thead>
<tr>
<th>CLP-1 or CLP-0+1 Fields</th>
<th>CLP-0 Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>QoS Class</td>
<td>Best Effort</td>
</tr>
<tr>
<td>QoS Peak Cell Rate</td>
<td>0</td>
</tr>
<tr>
<td>QoS Sust Cell Rate</td>
<td>0</td>
</tr>
<tr>
<td>QoS Max Burst Size</td>
<td>0</td>
</tr>
<tr>
<td>QoS Cell Delay VT</td>
<td>0</td>
</tr>
<tr>
<td>QoS Tagging</td>
<td>Off</td>
</tr>
<tr>
<td>QoS CLP0 Peak Cell Rate</td>
<td>0</td>
</tr>
<tr>
<td>QoS CLP0 Sust Cell Rate</td>
<td>0</td>
</tr>
<tr>
<td>QoS CLP0 Max Burst Size</td>
<td>0</td>
</tr>
</tbody>
</table>

Transmit Qos Parameters

<table>
<thead>
<tr>
<th>CLP-1 or CLP-0+1 Fields</th>
<th>CLP-0 Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>QoS Class</td>
<td>Best Effort</td>
</tr>
<tr>
<td>QoS Peak Cell Rate</td>
<td>0</td>
</tr>
<tr>
<td>QoS Sust Cell Rate</td>
<td>0</td>
</tr>
<tr>
<td>QoS Max Burst Size</td>
<td>0</td>
</tr>
<tr>
<td>QoS Cell Delay VT</td>
<td>0</td>
</tr>
<tr>
<td>QoS Tagging</td>
<td>Off</td>
</tr>
<tr>
<td>QoS CLP0 Peak Cell Rate</td>
<td>0</td>
</tr>
<tr>
<td>QoS CLP0 Sust Cell Rate</td>
<td>0</td>
</tr>
<tr>
<td>QoS CLP0 Max Burst Size</td>
<td>0</td>
</tr>
</tbody>
</table>

Bandwidth Parameters

Receive Bandwidth: 0  Transmit Bandwidth: 0
ATM VCL Service Information View

The ATM VCL Service Information view provides information about service providers associated with the ATM network. All service information is entered by the user and is provided for reference purposes only.

1. Access the ATM Logical Connection view
2. Highlight an ATM Link model
3. Select Service Information from the Icon Subviews menu

Note: The ATM VCL Service Information view is not supported by the UnmanAtmLink model.
The following information can be entered:

**Provider**
The name of the service provider associated with the ATM network. ATM customers who use multiple carriers can use this field to indicate which carriers provide service for which circuits.
Customer
Users who are service providers and manage other companies ATM networks can use this field to indicate who the service provider’s customer is.

Primary Contact
The name, phone number, and/or E-mail address of the person to contact if there is a problem with this circuit.

Secondary Contact
The name, phone number, and/or E-mail address of a secondary person to contact if there is a problem with this circuit.

Service Notes
This area can be used to enter miscellaneous information about this circuit such as Circuit ID or monthly cost.

To access the ATM VCL Service Information view highlight the ATM VCL model and select Information from the Icon Subviews menu.
Theory of Operations

This section describes the theory and software mechanisms behind the ATM Circuit Manager application.

Modeling Paradigm

In SPECTRUM, physical links between devices are managed by polling the status and performance data of the endpoints, for example, FDDI or HSSI interfaces. There is no difference in managing virtual links then there is in managing physical links except that the virtual link endpoints are Virtual Path Links (VPLs) or Virtual Channel Links (VCLs). These endpoints are modeled for all ATM clients that have supported ATM MIBs. These endpoints are NOT modeled for ATM switches unless an interface of an ATM switch is connected to an ATM_Cloud model. In this case, models are created for the VPLs and VCLs on that interface only.

Like physical interfaces, VPLs and VCLs have objects in a MIB that contain the status, bandwidth, and (depending on the MIB) performance statistics for these links. Whereas physical interfaces (as represented in the MIB-II ifTable) have a single-term index, VPLs have a two-term index and VCLs have a three-term index.

- A VPL index is in the form ifIndex.VPI, where ifIndex is the index of the physical interface the VPL runs on, and VPI is the Virtual Path Identifier - which is merely the name that the device calls the path.

- A VCL index is in the form ifIndex.VPI.VCI, where VCI is the Virtual Channel Identifier - which is merely the name that the device calls the channel. The VPI of a VCL may be "0", which may indicate that there is no Virtual Path. We will refer to VPLs and VCLs collectively as virtual links.
In SPECTRUM, the virtual link models are associated with the lower-layer interface model via the HASPART relation. As such, they will not be visible in the DevTop view of the device, but will be displayed in the Sub-Interface view of the lower layer interface model. The lower layer interface may be a physical ATM Interface model or, in the case of a VCL, may be a VPL model.

Virtual link models may have Links_with associations with other virtual link models indicating a logical connection. The Links_with association between virtual link models is never added by the discovery process. These associations are added manually by using the ATM Logical Connection view application or semi-automatically by providing an ASCII file to the ACMAsciModelingApp application. Both of these applications have been discussed in detail in previous sections.

Figure 14 shows what an actual SPECTRUM modeling of the ATM environment may look like after some Links_with associations are made.
In an actual ATM network environment, there would be two switches collected by the ATM_Network, and the port of one switch would be connected to the port of the other via a SwitchLink model. Figure 14 omitted those details to save space and simplify the image.
Fault Suppression

Because ATM link models are derived from the Port model type, their Internal_Link_Status attribute is read every polling interval. This attribute is calculated based on the value of the administrative and operational status of the link. For devices supporting the standard ATM MIB, these objects are atmVclAdminStatus and atmVclOperStatus for channel links, and atmVplAdminStatus and atmVplOperStatus for path links. If the value of Internal_Link_Status is not active, it is assumed that an error condition has occurred. An attempt is made to isolate the problem to either this link model or its "parent" model. This is done by reading the Internal_Link_Status of the parent model (the parent model could be a VPL or an interface).

If the parent model is active, a RED alarm is asserted on this link model. If the parent is NOT active, a GRAY alarm is asserted on this link model. Since the parent model's Internal_Link_Status attribute has just been read, the model's intelligence will assert either RED or GRAY if it is active.

Link Model Configuration

As previously discussed in this document, the main feature of the ATM Circuit Manager is the creation of models to represent VCLs and VPLs on ATM switches and clients. The VCLs and VPLs on switches are typically not modeled. Management of the circuits is mainly done via SNMP communication with the ATM clients. An exception to this rule is made when an interface of an ATM switch is connected to an ATM_Cloud model. When this occurs, only the links associated with that interface are modeled. These links are necessary to resolve the link-to-link connectivity across an ATM_Cloud. This connectivity must be done manually by the user, or this process may be automated by an application that reads in an ASCII file that identifies these connections.

Additionally, a user may manually force link model creation on any switch by changing the “Create Link Models” field to TRUE in the ATM application's ATM Link Modeling Options view, and then clicking the Reconfigure Now button in the same view. Intelligence attached to the ATM application model is responsible for ATM link model configuration.
The actual creation of link models is done by reading the VPL and VCL tables are determine which links exist on a device. SPECTRUM relations are read to get a list of existing SPECTRUM link models and the list of links on the device is compared to the list of SPECTRUM models. The differences will indicate which models must be destroyed and which links need new models created.

**Load Calculation**

Two statistical attributes indicating load are displayed in the ATM Link Performance view. They are \( rcvLoad \) and \( xmtLoad \). The formulae for these attributes are as follows:

\[
rcvLoad = \frac{rcvCellsPerSecond \times 100}{rcvBandwidth} \\
\]

\[
xmtLoad = \frac{xmtCellsPerSecond \times 100}{xmtBandwidth} \\
\]

The \( rcvBandwidth \) and \( xmtBandwidth \) attributes are defined by either the Peak Cell Rate (PCR) or Sustainable Cell Rate (SCR) depending on the Quality of Service (QoS) type. For Variable Bit Rate (VBR) circuits, the bandwidth is defined as the SCR. For all other types of service, the bandwidth is defined as PCR. This means that for VBR circuits, the load can exceed 100%. Users who want to always use PCR as bandwidth (even for VBR circuits) may override the \( rcvBandwidth \) and \( xmtBandwidth \) values by writing to the \( rcvBandwidthOver \) and \( xmtBandwidthOver \) attributes.

The \( rcvCellsPerSecond \) attribute is calculated by reading the attribute pointed to by \( rcvCells_Attr \) and the \( upTime \) attribute over a particular interval, and subtracting the first values from the second values. This gives us a delta of cells received and a delta of micro seconds elapsed. By dividing the delta cells by delta micro seconds, and then multiplying by one hundred, we arrive at the \( rcvCellsPerSecond \) value.

The \( rcvLoad \) and \( xmtLoad \) are graphed in the ATM link model’s Performance view, and can be logged for historical reports.
Threshold Alarm Generation

High and low thresholds are provided for $rcvLoad$ and $xmtLoad$. The $rcvLoad$ and $xmtLoad$ values are calculated using SpectroWATCH. These SpectroWATCH expressions are only evaluated for link models that have $Polling_Status$ set to TRUE. $Polling_Status$ is set to FALSE by default to limit management traffic over ATM links.

The $rcvLoad$ and $xmtLoad$ are read every polling interval. If the value of $rcvLoad$ exceeds the value of the $hiRcvLoadAlarmSet$ attribute (or is less than the value of the $lowRcvLoadAlarmSet$ attribute) an appropriate alarm will be asserted. If the value later drops below the $hiRcvLoadAlarmReset$ value (or rises above the $lowRcvLoadAlarmReset$ value), the alarm will be disasserted. An event, indicating that the threshold was violated, will persist.

The threshold alarms for $xmtLoad$ are asserted and disasserted in the same manner as $rcvLoad$. 
Index

Symbols

“best effort” 40

A

ABR 40, 41, 43
ACMAsciiModelingApp 16, 29, 34, 49
Add Link view 27
alarms 36, 51
ATM and Frame Relay 23
ATM cell 6
ATM interface 18
ATM Interface model 11, 49
ATM interface model 14
ATM Link 36, 38, 45
ATM link 51
ATM Logical Connection view 29
ATM MIBs 48
ATM_Cloud 8, 9, 48
ATM_Cloud model 8, 17, 18, 20, 25, 34, 51
ATM_Network 50
ATM_Network model 7, 10, 16, 20, 25
ATM2 MIB 9
atmVclAdminStatus 51
ATMVclLink 11
atmVclOperStatus 51
atmVplAdminStatus 51
atmVplOperStatus 51
Available Bit Rate 40

B

bandwidth 40, 52
Bandwidth Parameters 43

C

CBR 40, 41, 43
Cell Loss Priority 42
Channel 15
Cisco CA-CONN-MIB 9
Cisco routers 31
CiscoPingApp 31, 33
CLP 42
CLP bit 41, 42
Constant Bit Rate 40
Customer 47

D

Device Topology view 18
DLCI Port model 30

E

EnableRemotePing 31

F

fixed bandwidth 40
Fore Switch MIB 9
Frame Relay 22
Frame Relay interface 30
Frame Relay virtual link models 30

**H**
high threshold 38
high threshold values 37
high thresholds 38
hiRcvLoadAlarmReset 53
hiRcvLoadAlarmSet 53
hybrid ATM network 22

**I**
ifIndex 48
index 48
Internal_Link_Status 51

**L**
LAN data 40
Lightstream switches 9
Link Modeling Options view 51
load 40, 52
Logical Connection view 9, 10, 16, 25, 30, 38, 45, 49
low threshold values 37
low thresholds 38
lowRcvLoadAlarmReset 53
lowRcvLoadAlarmSet 53

**M**
managed virtual circuit 27
Maximum Burst Size 40

maximum time delay variation
tolerance 41, 43
modeling procedures 16
modeling schemes 7, 16

**N**
NumberOfPingPackets 31

**O**
Open Shortest Path First 32
OSPF 32

**P**
Path 15
PCR 52
Peak Cell Rate 40, 52
Performance view 52
Permanent Virtual Channels 11
Permanent Virtual Circuits 6, 15
Permanent Virtual Circuits (PVCs) 6
Permanent Virtual Paths 11, 15
PingFailuresAllowed 32
PingInterval 31
PingPacketSize 32
Polling_Status 53
Provider 46
PVC 31
PVCs 11, 15
PVP 15
PVPs 11
Index

Q
QoS 52
QoS Cell Delay VT 41, 43
QoS Class 40, 42
QoS Classes 40
QoS CLPO Max Burst Size 41, 42
QoS CLPO Peak Cell Rate 42
QoS CLPO Sust Cell Rate 42
QoS connection 40
QoS Max Burst Size 42
QoS Peak Cell Rate 40, 42
QoS Sust Cell Rate 42
QoS Tagging 42
Quality of Service 52

R
rcvBandwidth 52
rcvBandwidthOver 52
rcvCells_Atrr 52
rcvCellsPerSecond 52
rcvLoad 52
Receive Bandwidth 43
Receive CPS 37
Receive QoS 40
Received Load 37
red alarm 31
remote pings 31
Restricted Rights Notice 3
RFC1695 8

S
SCR 52
set thresholds 38
SNMP MIBs 8
Starting 25

Starting the ATM Logical Connection 25
Starting the ATM Logical Connection view 25
Sustainable Cell Rate 52
Sustained Cell Rate 40, 43
SVC 6
SW_Link model 16
Switched Virtual Circuit 6

T
Threshold 38
threshold alarms 53
Threshold view 36
trademarks 2
Transmit Bandwidth 43
Transmit CPS 37
Transmit Load 37
Transmit QoS 42

U
UBR 40, 43
Unmanaged Link model 29
Unmanaged Link option 29
UnmanagedAtmLink model 29
UnmanAtmLink 34, 45
UnmanAtmLink model 12, 30
Unspecified Bit Rate 40
upTime 52

V
Variable Bit Rate 40, 52
VBR 40, 41, 43, 52
VCI 6, 15
Index

VCL 8
VCL index 48
VCL Link model 24
VCL QoS (Quality of Service)
  Information view 40
VCL Quality of Service 24
VCL Service Information view 45
VCL Threshold 24
VCLs 48
Virtual Channel Identifier 6, 15, 48
Virtual Channel Link 8
virtual channel link 14
Virtual Channel Links 48
virtual circuits 27
virtual link models 27
virtual links 48
Virtual Path Identifier 6, 15, 48
Virtual Path Link 8
virtual path link 14
Virtual Path Links 48
VPI 6, 15
VPL 8, 51
VPL index 48
VPL model 49
VPLs 48

W

WA_Link model 12
WA_Segment model 12

X

xmtBandwidth 52
xmtBandwidthOver 52
xmtLoad 52